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 به نام یگانه معمار هستی

 

، طراحی به روش حالت های حدی به عنوان تنها 2931در مبحث دهم مقررات ملی ساختمان ایران، ویرایش سال 

 AISC. ضوابط این آئین نامه تطابق نسبتاً کاملی با ضوابط آئین نامه ه استروش طراحی سازه های فولادی ارائه گردید

، که بصورت ETABSدر ضوابط لرزه ای دارد. از طرفی نرم افزار  AISC 341-10در طرح المانها و  360-10

ور مناسبی در خود گسترده ای در ایران برای طراحی سازه های متعارف مورد استفاده قرار می گیرد، این ضوابط را بط

بر آن شد  زشهرداری شیرایت کنترل و نظارت ساختمان زه مدیرسا ، کارگروهموضوعداده است. با توجه به این  جای

در زمینه استفاده از این نرم افزار و تنظیمات مربوط به طراحی، هنگام استفاده از روش حالت های حدی،  راهنما ای

 ته وداش مربوطه رم افزارنخواننده آشنایی مناسبی با  آن بوده کهارائه نماید. لازم به ذکر است در این راهنما فرض بر 

 ذکر نشده است. در این راهنما کار با نرم افزارنکات ابتدایی مربوط به  بنابراین

 

 اند: ریبه شرح ز مراجع مورد استفاده در این راهنما

 

1- Steel Frame Design Manual: AISC360-05 / IBC 2006 (2010); Computers and 

Structures Inc. ; Berkeley, California 

2- Technical Note; 2005 AISC Direct Analysis Method (2009); Computers and 

Structures Inc. ; Berkeley, California 

3- AISC 360-10; Specification for Structural Steel Building, American Institute of 

Steel Construction; Chicago, Illinois 

4- AISC 341-10; Seismic Provisions for Structural Steel Buildings, American 

Institute of Steel Construction; Chicago, Illinois 

 

ما از این رو از ش ایهام نیست. و ابهام ،نگارشی فراوان، این اثر مصون از ایرادهایی نظیر غلطهای فنی، هایبا وجود تلاش

نشانی الکترونیکی مراتب را به  بهامو ا کالاش ضا دارد در صورت مشاهده هر گونهگرامی صمیمانه تقا مهندسان

shirazmn.str@gmail.com شود. فراهم آنها برطرف نمودن و شناسایی موجبات تا گزارش فرمایید 
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 ETABS افزار نرم در حدی های حالت روش به فولادی های سازه طراحی و تحلیل مدلسازی، به مربوط نکات

 

آشنایی دارند، با انجام تنظیمات زیر می توانند سازه فولادی  ETABS 9.7.4همکارانی که با طراحی سازه های فولادی به روش تنش مجاز در نرم افزار 

 خود را به روش حالتهای حدی مطابق با مبحث دهم مقررات ملی ایران طرح نمایند.

 

الاستیسیته فولاد را به قرار شکل زیر  مقادیر جرم واحد حجم، وزن واحد حجم و مدول Define > Material Property Dataدر قسمت  -1

می باشد. همچنین در آئین نامه مبحث  ρ =γ/9.81به قرار   (γ)و وزن واحد حجم  (ρ)وارد نمایید. دقت کنید که رابطه بین جرم واحد حجم 

 ذکر شده است. 2MPa = 2039000 kgf/cm 52.0x10برابر  Eمقدار  1991دهم مقررات ملی سال 

 

 
 (kg-mت مصالح فولاد )واحدها بر حسب تعریف مشخصا (1) شکل

 

سازه فولادی را بدون کنترل ملزومات لرزه ای مندرج در آئین نامه )مانند کنترل فشردگی، کنترل  ETABS 9.7.4در صورتی که بخواهید برنامه  -1

، کنترل نیاز به ورق پیوستگی و ورق مضاعف در قابهای خمشی و ... ( طرح نماید، فاصله مهارهای جانبی تیرها، کنترل ضریب لاغری مهاربندها
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در قسمت  Section Designer (SD)ولی ترکیبات بار تشدید یافته را بر روی ستونها اعمال کند، استفاده از مقاطع ساخته شده در برنامه

Define > Frames Sections .بلامانع است 

 

 

 

 توسط برنامه امکان پذیر است. به شرط عدم نیاز به ضوابط لرزه ای Generalیا  SDاستفاده از مقاطع  (1) شکل

 

، مرده دیوار، زنده با امکان کاهش سربار )عمدتاً بارهای زنده با مقدار Super Deadحالتهای بار مورد استفاده مانند بارهای مرده کف، مرده نوع  -9

 Defineدر قسمت  بع(، زنده بدون امکان کاهش سربار، زنده بام، بار برف، بارهای زلزله، بارهای فرضی و ... راکیلوگرم بر متر مر 055کمتر از 

> Static Load Cases .تعریف نمایید 

 

 

 تعریف حالتهای بار (9) شکل
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، ASCE/SEI 7-10و یا آئین نامه  1991دقت نمایید که در ترکیبات بار معرفی شده در مبحث ششم مقررات ملی ساختمان ویرایش سال 

در نظر گرفته شده است. بنابراین ضریب رفتار  1.0ضریب بار زلزله در ترکیبات بار با فرض استفاده از ضریب رفتار سطح طراحی نهایی و برابر 

تقسیم نموده و سپس نیروی زلزله را محاسبه نمود. به عبارت دیگر  1.4ویرایش سوم را می بایست بر عدد  1055در آئین نامه سازه مندرج 

ضریب زلزله ای باشد که قبلًا در روش طراحی به روش تنش مجاز استفاده  1.4ضریب زلزله مورد استفاده در روش طراحی حدی می بایست 

استفاده می  0.1375زلزله مربوط به قاب مهاربندی همگرای معمولی در طراحی به روش تنش مجاز قبلاً عدد  می شد. بطور مثال اگر ضریب

ویرایش چهارم نیازی  1055ضریب رفتار آئین نامه بدیهی است در صورت استفاده از  را وارد کنید. 0.1925شد، در طراحی به روش حدی عدد 

 به این اصلاح نیست.

 

 

 ضرب شوند. 1.4ضریب بارهای زلزله می بایست در عدد  (4) شکل

 

اعمال بار فرضی مربوط به ناشاقولی  و ویرایش های بعدی( AISC360-05)به بعد  1550در آئین نامه طراحی سازه های فولادی آمریکا از سال 

می شود، ضریبی از کل بار ثقلی می باشد. به طور  مجاز ستونها در طرح سازه الزامی شده است. مقدار این بار که بصورت جانبی بر سازه اعمال

و با شرایطی می تواند تنها در ترکیبات بار ثقلی اعمال  (N=0.002 Y)برابر بار ثقلی است  0.002معمول بار فرضی مربوط به ناشاقولی ستونها 

تعریف  Yو دیگری در راستای محور  Xاستای محور شود. به ازای هر حالت بار ثقلی تعریف شده، کاربر می بایست دو حالت بار فرضی یکی در ر

 L1  ،L1C  ،L2برای اعمال بار مرده و حالتهای باری به نام های  DWCو  D  ،DC  ،DWنماید. بطور مثال اگر کاربر حالتهای باری به نام های 

 ،L2C و حالتهای بار  برای اعمال بار زندهS  وSC حالت بار ثقلی  11حالت بار فرضی به ازای این  91باشد،  برای تعریف بار برف در نظر گرفته

 Typeبرای هر حالت بار. نوع این بار در قسمت  Yو دیگری مربوط به بار فرضی جهت  Xمی بایست تعریف گردد، یکی مربوط به بار فرضی جهت 

 انتخاب شود. NOTIONALمی بایست  Static Load Casesمربوط به دستور 
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 به ازای هر حالت بار ثقلی Xبار فرضی راستای  تعریف حالت های (0) شکل

 

 

 به ازای هر حالت بار ثقلی Yتعریف حالت های بار فرضی راستای  (1) شکل

 

را تعریف نمایید. این ترکیبات  1991ترکیبات بار مبحث ششم مقررات ملی ساختمان سال  Define > Load Combinationsدر قسمت  -4

معاونت شهرسازی و معماری شهرداری شیراز تشریح شده است. ذکر چند نکته درباره این  99-151-1بار بطور مفصل در دستورالعمل شماره 

 ترکیبات بار خالی از لطف نیست:
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  1.71 ≥بارهای فرضی مربوط به ناشاقولی ستون می تواند تنها در ترکیبات بار ثقلی وارد شود به شرط آنکهst /Δ2ndΔ  باشد. بطور

 این شرط برقرار است.  معمول برای اکثر ساختمانها

  در ترکیبات بار پیش فرض برنامهETABS 9.7.4  نیز بارهای فرضی تنها به ترکیبات بار ثقلی افزوده می شوند. اما در برنامهETABS 

گزینه ای برای افزودن بارهای فرضی به ترکیبات بار شامل بار زلزله  Steel Frame Design Preferencesدر قسمت  2013

 . (?Add Notional load cases into seismic combos)دارد  نیز وجود

  ضریب بارهای فرضی در یک ترکیب بار دقیقاً مانند ضریب بار ثقلی نظیر است. بطور مثال اگر در ترکیب بار ثقلی ضریب بار زنده برابر

 است. 1.6باشد، ضریب حالت بار فرضی نظیر نیز  1.6

 فقط بار فرضی یک راستا اعمال می گردد. مثلاً برای ترکیب بار ثقلی شامل بارهای زنده و مرده یک دفعه  در یک ترکیب بارگذاری

وارد شوند. همچنین بار جانبی مربوط  Yو بار دیگر بارهای فرضی مرده و زنده جهت  Xمی بایست بارهای فرضی مرده و زنده جهت 

هر دو با  Xاعمال شود. یعنی یک بار می بایست بار فرضی مرده و زنده جهت  به بار فرضی در هر دو راستای یک امتداد می بایست

علامت مثبت و بار بعد هر دو با علامت منفی لحاظ شوند. بنابراین هر ترکیب بار ثقلی با اعمال بارهای فرضی به چهار ترکیب بار 

 تبدیل می شود.

 کیلوگرم بر مترمربع )به شرط آنکه پارکینگ یا  055های زنده کمتر از مطابق آئین نامه در ترکیبات بار شامل بار زلزله، ضریب بار

 است. 0.5محل تجمع نباشد( برابر 

  در ترکیبات بار معرفی شده توسط آئین نامه مشاهده می شود که بار زنده بام در ترکیبات بارگذاری شامل بار زلزله وجود نداشته و

 ست.وارد شده ا 0.2بجای آن بار برف بام با ضریب 

  جهت های متعامد نیز  %95و  %155در ترکیبات بار تشدید یافته می باید اثر  1991مطابق مبحث دهم مقررات ملی ساختمان سال

 اثر نمی کند. آنبه   0Ωاعمال گردد. در این ترکیبات بار، زلزله راستای قائم نیز وارد شده ولی ضریب 

  اگر بخواهیم خود نرم افزارETABS ی زلزله تشدید یافته با در نظر گرفتن اثر زلزله های متعامد بطور صحیح محاسبه ستونها را برا

زلزله های متعامد تعریف کرده و سپس در ترکیبات  %95یک راستا و  %155نماید، ابتدا می بایست ترکیب بارهایی فقط شامل زلزله 

 .بار دیگری، این ترکیب بار شامل زلزله را با بارهای ثقلی ترکیب نماییم

 

 Do Not Include Specialرا همیشه غیرفعال کنید. به عبارت دیگر گزینه  Define > Special Seismic Load Effectsقسمت  -0

Seismic Design Data .را در این قسمت انتخاب نمایید 

در دو قسمت مختلف از کاربر می پرسد که آیا کنترل های طرح لرزه ای )مثل طرح  ETABS 9.7.4این انتخاب بدان دلیل است که برنامه  

در قسمت  Options( و یکی در منوی Defineستونها برای زلزله تشدید یافته( را انجام دهد و یا ندهد. یکی در این قسمت )در منوی 

Options>Preferences>Steel Frame Design  در منوی .Define چه این گز ( ینه را فعال کنیدInclude ….  و )را انتخاب کنید

صورت گرفته به آن ارجحیت دارد. بطور مثال اگر  Options(، تنظیمی که در منوی … Do Not Includeچه این گزینه را غیرفعال کنید )

 Do Notیا  Includeگزینه  Defineی بگویید برنامه کنترل های لرزه ای را انجام دهد، برنامه مستقل از آنکه در منو Optionsدر منوی 

Include  را انتخاب کرده باشید، کنترل های لرزه ای را انجام می دهد. همچنین اگر در منویOptions  بگویید برنامه کنترل های لرزه ای را

اشید، کنترل های لرزه ای را را انتخاب کرده ب Do Not Includeیا  Includeگزینه  Defineانجام ندهد، برنامه مستقل از آنکه در منوی 

فعال نمایید، برنامه مقدار  Optionsو هم در منوی  Defineانجام نخواهد داد. تنها یک نکته وجود دارد که اگر طرح لرزه ای را هم در منوی 

0Ω  را از منویDefine  0قرائت می کند و با مقدارΩ  معرفی شده در منویOptions .کاری نخواهد داشت 
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آنکه اگر کاربر بخواهد کنترل های لرزه ای را خودش انجام دهد، مثلاً ترکیبات بار تشدید یافته را خود تعریف و در برنامه اعمال کند،  نکته بعدی

 طرح لرزه ای برنامه را غیرفعال کند. Optionsو  Defineمی بایست در هر دو قسمت 

 Omega Factorطرح لرزه ای برنامه را فعال نمایید، مانند شکل زیر آن را تکمیل کنید. در قسمت  Defineدر صورتی که بخواهید در منوی 

است. در صورتی که قصد  9و قابهای خمشی عدد  0/1، قابهای دوگانه عدد  1را وارد نمایید. این ضریب برای قابهای مهاربندی عدد  0Ωمقدار 

را  Do Not Include Special Seismic Design Dataام دهید، در این قسمت گزینه دارید کنترل های لرزه ای را بصورت دستی انج

  انتخاب نمایید.

 

 
 Defineمعرفی پارامترهای طرح لرزه ای در منوی  (7) شکل

 

 را مانند روال قبل انجام دهید. Assign، اختصاص های مربوطه در منوی  Defineپس از تنظیم بقیه موارد منوی  -1

فرض  LRFDدر طرح سازه ها به روش  ETABSرا فعال نمایید. برنامه  P-Δانجام تحلیل  Analyze > Set Analysis Optionsدر قسمت  -7

را در لنگرهای بدست آمده  B2می کند نیروهای بدست آمده از تحلیل، نیروهای ناشی از تحلیل مرتبه دوم هستند و بنابراین ضریب تشدید لنگر 

طراحی نماییم، حتماً باید گزینه مربوط  LRFDبه روش  ETABSرگاه بخواهیم سازه فولادی را در برنامه ضرب نمی کند. پس نتیجه می گیریم ه

داشتیم. دقت کنید با   ETABSدر برنامه  ASDروند برخلاف روالی بود که در طراحی به روش  را فعال نماییم. این P-Δبه انجام تحلیل 
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را انجام نمی دهد. بنابراین برای تشدید لنگر بارهایی که ایجاد حرکت  P-δجام داده ولی تحلیل را ان P-Δفعال کردن این گزینه برنامه تحلیل 

 را نیاز داریم. B1جانبی نمی کنند هنوز ضریب 

 
 P-Δفعال کردن تحلیل  (0) شکل

 

صورت گیرد را وارد نمایید. این ترکیب  P-Δترکیب بار ثقلی ای که می بایست بر اساس آن تحلیل  Set P-Delta Parametersدر قسمت 

برنامه ذکر شده است، می بایست بزرگترین ضرایب مربوط به بار ثقلی در ترکیب بارهای شامل بار جانبی باشد. بطور  Helpبار مطابق آنچه در 

 (1.2D+0.5L+0.2S)قلی باشد، ترکیب بار ث EE(0.9D)و    EE(1.2D+0.5L+0.2S)مثال اگر ترکیب بارهای شامل بار جانبی بصورت 

شامل بار زلزله، تحلیلی دقیق و برای ترکیبات بار دوم تحلیلی محافظه کارانه ارائه خواهد کرد. این ترکیب بار ثقلی را در  برای ترکیبات بار اول

 قسمت مربوطه وارد کنید.
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 P-Δترکیب بار ثقلی مربوط به تحلیل  (9) شکل

 

 Options > Preferences > Liveمعرفی کرده اید، برای انجام تنظیمات مربوطه وارد قسمت  در صورتی که بار زنده شامل کاهش سربار را -0

Load Reduction  شوید و در این قسمت تنظیمات را مانند شکل زیر انجام دهید. دقت کنید که فرمول کاهش سربار معرفی شده در مبحث

تنها ذکر این نکته  و یا ویرایش های بعدی این آئین نامه تطابق دارد. ASCE7-95دقیقاً با آئین نامه  1991ششم مقررات ملی ساختمان سال 

در نظر می  2و برای همگی تیرها، مهاربندها و دیوارها این ضریب را برابر  4را برابر  LLKبرای همگی ستونها ضریب  ETABSست که برنامه لازم ا

ی کناری با کنسول و تیر طره بیشتر از مقداری است که مبحث ششم در نظر گرفته . این اعداد برای ستونهای کناری با کنسول، تیرها گیرد

 فرمول کاهش سربار مطابق مبحث است و بنابراین برای این حالتها می تواند کاهش سربار اعمال شده توسط برنامه کمی در خلاف اطمینان باشد.

 به قرار زیر است: ASCE7-95ششم مقررات ملی و 
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 وط به کاهش سربارتنظیمات مرب (15) شکل

 

 Options > Preferences > Steel Frameپس از انجام تحلیل سازه برای انتخاب آئین نامه طراحی و تنظیمات مربوطه وارد قسمت  -9

Design ( تکمیل نمایید. در این تنظیمات به نکات زیر دقت کنید:11شوید. قسمتهای مختلف را مطابق شکل ) 

 

  آئین نامه طراحی راAISC360-05/IBC2006 .انتخاب کنید 

  در تمام انواع قابهایSMF  ،)قاب خمشی ویژه(IMF  ،)قاب خمشی متوسط(SCBF  ،)قاب مهاربندی همگرای ویژه(OCBF  قاب(

)قاب مهاربندی واگرا(، برنامه  EBF)قاب مهاربندی همگرای معمولی با جداگر لرزه ای( و  OCBFIمهاربندی همگرای معمولی(، 

ETABS  کنترل فشردگی مقاطع را قبل از طراحی انجام داده و درصورتی که مقطعی فشرده نباشد، آنرا طراحی نخواهد کرد. تنها

انتخاب کنید، برنامه بدون کنترل ضابطه فشردگی، مقاطع را طراحی می نماید. از نظر فرمولهای کنترل  OMFوقتی که نوع قاب را 

ی انتخابی مختلف وجود ندارد و با تغییر نوع سیستم لرزه بر، تنها کنترلهای مربوط به ضوابط اعضاء فولادی، هیچ تفاوتی بین قابها

 لرزه ای فرق خواهد کرد.

  مقاطعی را که در برنامهSD  تعریف کرده ایم، مقطع نوعGeneral  بوده و از نظر برنامهETABS .این مقاطع غیرفشرده می باشند 

 زه، قاب مهاربندی همگرای معمولی باشد، می توانید نوع قاب را در برنامه در صورتی که سیستم باربر جانبی ساOMF  .انتخاب نمایید

فشردگی مقاطع را کنترل نکرده اما کنترل ستونها تحت ترکیبات بار تشدید یافته را انجام می دهد. مزیت  ETABSبدین ترتیب برنامه 

نیز در طرح اعضاء استفاده نمایید. یادآوری می شود در قابهای  SDبرنامه این روش آن است که می توانید از مقاطع تعریف شده در 

 و مهاربند فشرده باشند. دهانه مهاربندی مهاربندی هم محور با شکل پذیری معمولی، مطابق آئین نامه می بایست مقاطع تیر، ستون

)محدودیت لاغری مربوط به اعضاء با شکل  mdλمی بایست فشرده لرزه ای با محدودیت  0و  7همچنین مقاطع تیر و مهاربند نوع 



 

 

 معاونت معماری و شهرسازی شهرداری شیراز

 مدیریــت کنتــرل و نظــارت ساختمــان
 

 03 از 13 صفحه

 

49-1 50-1راهنمای شماره   

 ETABSنکات طراحی به روش حالت های حدی در 

 

می بایست برای ترکیب بارهای ثقلی و ترکیب بار شامل  0و  7پذیری متوسط( باشند. علاوه بر این تیرهای متصل به مهاربندهای 

ها را می بایست بیشتر شود. در این صورت این کنترل 110نیز نباید از عدد  0و  7نیروی نامتعادل طرح شوند. لاغری مهاربندهای 

 بصورت دستی انجام داد.

 

 LRFDتنظیمات مربوط به طراحی سازه فولادی به روش  (11) شکل
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  99-159-1 شماره ، مطابق دستورالعملباشدقاب خمشی با شکل پذیری متوسط یا ویژه  صورتی که سیستم لرزه بر جانبی،در 

بوده و ( Hستونهای ساخته شده از ورق )مثل باکس یا  بایستی مربوطه می ستونها شهرداری شیراز، معاونت شهرسازی و معماری

شکل نورد شده  Iد. همچنین تیرهای اصلی نیز به طور معمول مقاطع نباشاستفاده از پروفیلهای مرکب برای مقطع ستون مجاز نمی 

 I/Wideطع انظیر مق شدهی تعریف از پروفیل ها ETABSدر برنامه . بنابراین در این حالت بهتر است هستندیا ساخته شده از ورق 

Flange  و یاBOX  بدون نیاز به ساختن پروفیلها در برنامه(SD) در قسمت تنظیمات استفاده شده و نوع قاب را IMF  یاSMF 

نیم تا برنامه کنترل های لرزه ای مربوطه را انجام دهد. کنترل هایی را که برنامه در این حالت انجام می دهد عبارتند از انتخاب ک

ترل فشرده لرزه ای بودن تیرها و ستونها، کنترل فاصله مهار جانبی بال تیرها، کنترل ستونها در ترکیبات بار تشدید یافته، کنترل کن

لاغری ستونها در قابهای خمشی ویژه، کنترل ضابطه ستون قوی و تیر ضعیف در ستونهای قاب خمشی ویژه )فقط برای ساختمانهایی 

انتخاب شوند(، کنترل لزوم و طرح ورق پیوستگی و همچنین کنترل تنش برشی و ضخامت ورق مضاعف  Fو  Eکه گروه لرزه ای آنها 

 شکل برای خمش حول محور قوی. Hدر ستونهای با مقطع 

  در صورتی که نوع سیستم لرزه بر جانبی، قاب مهاربندی برون محور باشد، برای آنکه برنامهETABS  بتواند کنترل های لرزه ای

انتخاب کرده و پروفیهای تیر و ستون و مهاربند را یا از  EBFه را انجام دهد، می بایست نوع قاب را در قسمت تنظیمات برنامه مربوط

 مقاطعاستفاده کنیم و یا اگر از پروفیلهای دیگر مثل  BOXو یا  I/Wide Flangeمقطع مثل  ETABSپروفیل های شناخته شده در 

شکل یا دیگر مقاطع شناخته شده  Iاین مقاطع را بصورت مقاطع  PROPERدا با استفاده از برنامه مرکب استفاده می نماییم، ابت

معادل سازی کرده و سپس وارد برنامه نمود تا برنامه بتواند ضوابط طرح لرزه ای را روی آنها کنترل نماید. کنترل  ETABSتوسط 

ستون دهانه مهاربندی و مهاربند،  -ز کنترل فشرده لرزه ای بودن تیر پیوندانجام می دهد عبارتند ا EBFهایی را که برنامه برای قاب 

ستون دهانه مهاربندی، کنترل ستونها در ترکیبات بار تشدید یافته  -مهاربند -تیر خارج پیوند -کنترل ضوابط طرح لرزه ای تیر پیوند

 وابط بصورت دستی بسیار وقت گیر می باشد، برای طرح اینو کنترل دوران تیر پیوند. توصیه می شود با توجه به اینکه کنترل این ض

کنترلهای لرزه ای مربوطه  ETABSنوع قاب حتماً از یکی از دو روش ذکر شده در فوق برای تعریف مقاطع استفاده کرده تا خود برنامه 

 را انجام دهد.

  در قسمتSeismic Design Category  گروه لرزه ای ساختمان را یکی از انواعD  تاF  ًترجیحا(F انتخاب کنید. همچنین در )

مقدار ضریب رفتار نهایی سسیتم لرزه بر را معرفی نمایید. گروه های لرزه ای ساختمانها در آئین نامه بارگذاری  System Rقسمت 

ثر است( و همچنین مربوط به این آئین نامه مؤ Sd1و  Sdsآمریکا بر اساس شدت لرزه خیزی منطقه و نوع خاک )که در پارامترهای 

مربوط به ساختمان با کمترین شدت لرزه خیز و   Aدسته بندی می شوند که  Fتا  Aمیزان اهمیت ساختمان )میزان ریسک( از 

تمهیدات لرزه ای برای سازه ای که در دسته  AISC341با بیشترین میزان می باشد. مطابق آئین نامه  Fاهمیت و خاک مناسب، ولی 

 یا کمتر باشد در نظر گرفته نمی شود. 9قرار دارند و همچنین ضریب رفتار نهایی آنها  Cتا  Aبندی لرزه ای 

  ضریب اهمیت ساختمان را در قسمتImportant Factor  و در قسمت  1.0برابرSystem Cd  0.7مقدارR  را وارد نمایید. این

رل دوران تیر پیوند استفاده می شوند. برای محاسبه دوران تیر انتخاب نمایید و برای محاسبه و کنت EBFاعداد تنها وقتی نوع قاب را 

تغییرمکان غیرخطی از ضرب  ASCE/SEI 7پیوند، از تغییرمکان جانبی واقعی )غیرخطی( سازه استفاده می شود. مطابق آئین نامه 

 ویرایش سوم ایران 1055مه ضریب تشدید تغییرمکان می باشد. در آئین نا dCبدست می آید که  IdC/تغییرمکان خطی در ضریب 

است.  بصورت جدولی ارائه dCبود که در ویرایش چهارم ضریب  معرفی شده 0.7Rبرای تبدیل تغییرمکان خطی به غیرخطی ضریب 

 بنابراین برای اینکه تناظر بین دو آئین نامه درست صورت گیرد، اعداد ذکر شده برای این دو قسمت وارد نمایید.
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  در قسمتSystem Rho  را بر اساس ضریب   1.2یا  1.0عددρ   .در قسمت وارد کنیدSystem Sds  را وارد نمایید ) 0عددSds 

در صورتی که سیستم باربر لرزه ای در یک  1055ایران یکی است(. در آئین نامه  1055در آئین نامه  A(1+S)در آئین نامه آمریکا با 

افزایش  %15می باشد ضرب می شود )نیروی زلزله  1.2که  ρزلزله آن راستا در عدد راستا به میزان مناسبی مهیا نشده باشد، نیروی 

در نظر گرفته  1.0ایران تا قبل از ویرایش چهارم این ضریب وجود نداشت. به عبارت دیگر این ضریب  1055می یابد(. در آئین نامه 

معرفی شده است. علاوه بر این در آئین نامه  1.2میزان  به ρویرایش چهارم ضریب  1055شده بود. هرچند در پیش نویس آئین نامه 

ASCE/SEI 7  برای در نظر گرفتن اثر مؤلفه قائم زلزله، تمام بارهای مرده به اندازهDS0.2S  افزایش یا کاهش داده می شود. در آئین

می  0ارت دیگر این ضریب برابر ویرایش سوم و پیش نویس چهارم این آئین نامه، چنین روشی دیده نشده است. به عب 1055نامه 

باشد. دقت کنید که در آئین نامه آمریکا این افزایش بار مرده بخاطر اثر زلزله قائم هم در ترکیبات بار عادی و هم در ترکیبات بار 

ر تشدید یافته اتشدید یافته، یک بار به صورت افزایشی و یکبار بصورت کاهشی می بایست اعمال گردد. بنابراین بطور مثال ترکیبات ب

 به قرار زیر است: ASCE/SEI 7مطابق آئین نامه 

 

را در ساخت ترکیبات بار پیش فرض معمولی و تشدید یافته خود استفاده می نماید. این برنامه این ضریب را برای  ρضریب  ETABSبرنامه 

 هر دو راستای ساختمان فقط یک عدد در نظر می گیرد.

  همانطور که مشاهده کردید در برنامهETABS 9.7.4  دو بار و در دو قسمت مختلف یکی در منویDefine > Special Seismic 

Load Effects  و دیگری در قسمتOptions > Preferences > Steel Frame Design  تنظیمات پارامترهای لرزه ای مثل

ρ  0وΩ   در را می پرسد. این ایراد برنامه است کهETABS 2013  برطرف شده است و تمامی تنظیمات مربوطه در یک قسمت

از عدد معرفی شده در منوی   0Ωو  Optionsاز عدد وارد شده در قسمت   ρنیز  ETABS 9.7.4تجمیع شده اند. هرچند در برنامه 

Define  قرائت می شود. برنامهETABS ستفاده کرده و برای هر دو راستای این ضریب را برای ساخت ترکیبات بار تشدید یافته ا

 ساختمان فقط یک عدد می تواند بگیرد.

  در قسمتDesign Provision  روش طراحی راLRFD  و بعدی آئین  1550انتخاب کنید. دقت نمایید که در ویرایش های سال

 ASDنیز برای طراحی وجود دارد. روش  (ASD)، روش مقاومت مجاز (LRFD)، علاوه بر روش ضرایب بار و مقاومت  AISC360نامه 

مقاومت  LRFDمعرفی شده در این آئین نامه بدین صورت است که ابتدا می بایست با استفاده از فرمول های ارائه شده برای حالت 

مت مقاوکاهش یابند تا به  φ ضریب کاهش مقاومتمحاسبه شوند. سپس به جای آنکه این مقاومت ها با  n(R(اعضاء  های اسمی

برسیم. بطور مثال برای محاسبه ظرفیت  n(R (Ω/مقاومت مجازتقسیم شده تا به   Ω ضریب اطمینانبرسیم، بر  φR)n( طراحی

ضرب کنیم تا به  φ=0.9را در عدد  n(T(حالت حدی تسلیم، بجای آنکه ظرفیت اسمی کششی عضو  کششی یک عضو تحت معیار

تقسیم می کنیم تا به مقاومت  Ω=1.67، مقاومت اسمی بدست آمده را بر عدد n= 0.9 Tn(φ T(مقاومت طراحی کششی عضو برسیم 

. هر چند مقاومت مجاز با نیروهای بدست آمده از ترکیبات بار تقریباً بدون ضریب مقایسه n/Ω = 0.6 Tn(T(مجاز کششی عضو برسیم 

می شود. اما مقاومت طراحی را می بایست با نیروهای بدست آمده از ترکیبات بار نهایی مقایسه نمود. در حقیقت می توان گفت که 
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یی دارند. ولی پایه محاسبات همان روش حدی می باشد. در این روش یک حقّه برای کسانی است که فقط با روش تنش مجاز آشنا

روش  ETABSارائه شده است. در هر صورت در این قسمت از برنامه  LRFDآئین نامه مبحث دهم مقررات ملی ایران نیز تنها روش 

LRFD .را انتخاب نمایید 

  در قسمتDesign Analysis Method  نوع تحلیل و طراحی برای پایداری راDirect Analysis  انتخاب نمایید. تا قبل از آئین

صورت می گرفت. در این روش  (Effective Length Method)طرح پایداری سازه فقط با روش طول مؤثر  AISC360-05نامه 

ی دبرای دیدن اثرات سیستم بر مقاومت یک عضو از ضریب طول مؤثر درهنگام طراحی استفاده می شد. این روش که با فرضیات متعد

 Directروش  AISC360-05همراه بود، روش مناسبی برای طرح پایداری همه سازه ها نبود. به همین دلیل در در آئین نامه 

Analysis  به عنوان یک راهکرد جدید در پیوست این آئین نامه آورده شد. در آئین نامهAISC360-10  روشEffective Length 

به جای آن به متن اصلی آئین نامه  Direct Analysisپیوست آئین نامه منتقل شد و روش که دارای محدودیت هایی می باشد، به 

در محاسبات مقاومت ستون در نظر گرفته می شود  1.0برابر  (K)ضریب طول مؤثر ستونها  Direct Analysisافزوده شد. در روش 

است. ولی  0.8های محوری، برشی و پیچشی برابر اما سختی اعضاء در تحلیل و طراحی کاهش داده می شود. ضریب کاهش سختی 

ضریبی است که وابسته به نیروی محوری اعضاء می باشد و   bτمی باشد. در این رابطه  b0.8 τضریب کاهش سختی خمشی برابر 

ده ائه شهرچه نیروی محوری عضو بیشتر باشد، این ضریب کمتر است. دقت کنید که کاهش سختی اعضاء در طراحی در فرمولهای ار

 توسط آئین نامه لحاظ شده است و نیازی به لحاظ کردن مجدد توسط ما نیست. 

باشد، امکان  1st/ Δ  2ndΔ   1.5 ≥نیز مطابق آئین نامه به شرط آنکه نسبت  Effective Lengthدر هر صورت استفاده از روش 

که بطور مناسبی طراحی شده باشند، برقرار است. برای قابهای مهارشده تفاوت زیادی بین  پذیر است. شرط اخیر در اکثر سازه هایی

 Effectiveوجود ندارد. دراین نوع قابها در صورتی که روش  Effective Lengthو  Direct Analysisاستفاده از دو روش 

Length  را انتخاب نماییم، ضریبEffective Length Factor (Minor , Major)  ستونها در قسمتOverwrite را بایستی

لحاظ کنیم. هر چند برای قابهای خمشی این دو روش می توانند تفاوت بسیار زیادی نسبت به هم داشته باشند. برای حالت  1.0

 استفاده شود. Direct Analysisاخیر توصیه می شود حتماً از روش 

  روش هنگامی کهDirect Analysis  را در برنامهETABS  برای تحلیل و طراحی پایداری سازه انتخاب می کنیم، خود برنامه بصورت

 نمود. Assignداخلی ضرایب کاهش سختی را اعمال می کند و نیازی به این نیست که بصورت دستی کاهش سختی ها را 

  در قسمتStiffness Reduction Method  گزینهTau-b Variable شد، هنگامی که از  را انتخاب نمایید. همانطور که گفته

ضرب می  0.8برای تحلیل و طراحی پایداری سازه استفاده می شود، سختی های اعضاء در ضرایب کاهش  Direct Analysisروش 

که متغیر بوده و وابسته به نیروی  1.0ضریبی است کوچکتر از  bτضرب می شود.  b0.8τشوند، بجز سختی خمشی که در ضریب 

گرفت(، به شرط آنکه بار  1.0برابر را  bτ را ثابت فرض کرده )چند می توان مطابق آئین نامه این ضریب محوری عضو می باشد. هر 

در تمامی ترکیبات بارگذاری، حتی ترکیبات بارگذاری شامل بار جانبی، افزود. این بار فرضی، اضافه بر  Y 0.001فرضی ای به اندازه 

برای است که بطور معمول تنها در ترکیبات بارگذاری ثقلی اعمال می گردد.  Y 0.002زه بار فرضی مربوط به ناشاقولی ستونها به اندا

هر دو گزینه  ETABSرا متغیر در نظر بگیریم. هر چند  bτآنکه دچار دردسرهای مربوط به این قضایا نشویم، بهتر است همیشه ضریب 

Tau-b Fixed  وTau-b Variable .را دارا می باشد 

  نکته ای که وجود دارد آن است که تا قبل از آنکه اولین طراحی بر اساس آئین نامهAISC360-05/IBC2006  با استفاده از روش

Direct Analysis  انجام شود، سختی های اعضاء سازه کاهش نیافته باقی خواهند ماند. اما پس از آن در صورت تحلیل دوباره سازه

ضرایب کاهش سختی اعمال می شوند و بنابراین از آن پس است که می توان بطور مثال مشاهده نمود  )بدون تغییر نوع آئین نامه(،

که تغییرمکان جانبی سازه و خیز تیرها بخاطر کاهش سختی افزایش یافته اند. برنامه پس از اولین طراحی بر اساس این آئین نامه با 
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کثر میزان تغییر سختی اعضاء و تعداد اعضایی که سختی آنها تغییر داشته پیامی را نمایش می دهد که حدا Direct Analysisروش 

برای کاهش سختی استفاده شده است و  Tau-b Fixed( حالتی را نشان می دهد که از روش 11است را نشان می دهد. شکل )

تغییر یافته  0.8به عدد  1.0عدد  می باشد )ضریب تغییر سختی از 0.2بنابراین تغییر ضریب کاهش سختی اعضاء حداکثر به اندازه 

استفاده نموده ایم. در این حالت حداکثر تغییر ضریب تغییر  Tau-b Variable( مثالی از سازه ای است که از روش 19است(. شکل )

 تغییر یافته است(. 0.61به حداکثر عدد  1.0بوده است )ضریب سختی خمشی از عدد  0.39سختی 

 ل های سازه در حالت حدی بهره برداری مانند کنترل دریفت، خیز تیر، محاسبه پریود و کنترل فرکانس، مطابق آئین نامه برای کنتر

تبدیل کرده و  AISC-ASD89نیاز به اعمال کاهش سختی اعضاء نیست. بنابراین برای مثلاً کنترل دریفت ابتدا آئین نامه را مثلاً به 

ه برای کنترل دریفت سازه استفاده نمایید. هرچند اگر سازه در مدلی که سختی کنید تا از نتیجه بدست آمد Runسپس مدل خود را 

سازه را کاهش داده اید جوابگوی دریفت مجاز بود، در مدل اصلی نیز این کنترل جوابگو خواهد بود. نکته دیگر آنکه با توجه به تغییر 

وده و نتایج تحلیل دینامیکی نیز تغییر می کند. راه حل آن سختی سازه، پریودهای مودهای ارتعاشی بدست آمده نیز اعداد بیشتری ب

( تحلیل نموده و سپس توزیع استاتیکی AISC-ASD89است که در مرحله آخر طراحی، یک مدل با سختی اصلی )تغییر آئین نامه به 

 .نظیر تحلیل دینامیکی نیروها را قرائت و سپس بر سازه اعمال و بر اساس آن سازه را کنترل نماییم

  

 

 (Tau-b Fixedپیام برنامه مبنی بر تغییر سختی اعضاء و نیاز به تحلیل مجدد سازه بر اساس سختی های جدید )روش  (11) شکل

 

 

 (Tau-b Variableپیام برنامه مبنی بر تغییر سختی اعضاء و نیاز به تحلیل مجدد سازه بر اساس سختی های جدید )روش  (19) شکل
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  در قسمتSecond Order Method  روشOrder stfied 1Ampli  را انتخاب کنید. بطور کلی دو روش برای در نظر گرفتن

در برنامه شناخته می شود، روش دقیق  Order ndGeneral 2آثار مرتبه دوم نیروها در محاسبات وجود دارد. روش اول که به نام 

مستقیماً در هنگام تحلیل سازه دیده شود. روش دوم که روشی تقریبی و  (P-δو  P-Δ)اثرات  است. در این روش اثرات مرتبه دوم

شناخته می شود، بدین صورت است که سازه را تحلیل مرتبه  Order stAmplified 1دارای محدودیت است در برنامه به نام روش 

 B1تشدید می نماییم.  B2و  B1رایب اول خطی کرده و در هنگام طراحی اعضای سازه، نیروهای بدست آمده از این تحلیل را با ض

ضریب تشدید مربوط به بارهای با حرکت جانبی  B2ضریب تشدید مربوط به بارهای بدون حرکت جانبی )معمولاً بارهای ثقلی( و 

ر نظر د 1.0می باشد را برابر  P-Δکه مربوطه به اثر  B2همواه ضریب  ETABS)معمولاً بارهای جانبی مثل زلزله( می باشد. برنامه 

 ETABSدر هنگام تحلیل سازه فعال شده است. نکته دیگر آنکه برنامه  P-Δمی گیرد. به عبارت دیگر همیشه فرض می کند تحلیل 

)اثرات مرتبه دوم مربوط به  P-δ)اثرات مرتبه دوم مربوط به بارهای با حرکت جانبی( را انجام داده ولی تحلیل  P-Δفقط تحلیل 

همواره در  بر این اساسرا محاسبه می نماید.  B1ضریب تشدید  می تواند( را انجام نمی دهد. بنابراین بارهای بدون حرکت جانبی

بدین صورت  ETABSروال طراحی برنامه   را فعال نمود. P-Δهنگام تحلیل و طراحی یک سازه به روش حدی، می بایست تحلیل 

در نظر می گیرد. اما در صورت  1را نیز محاسبه نکرده و برابر  B1ضریب  Order ndGeneral 2در صورت انتخاب گزینه است که 

 1.0را برابر  B2مقدار می کند. همانطور که گفته شد برنامه همواره محاسبه را  B1، مقدار Order stAmplified 1 انتخاب گزینه

کردن هستند.  Overwriteل قاب B2و  B1انتخاب شود، مقادیر  Order stAmplified 1اگر روش همچنین در نظر می گیرد. 

 بطور صحیحی محاسبه گردد. B1را انتخاب کنید تا مقدار  Order stAmplified 1گزینه بنابراین در این قسمت 

  مقادیر پیش فرض برنامه برای ضرایب کاهش مقاومتφ .را که مطابق آئین نامه می باشد، تغییر ندهید 

  در صورتی که بخواهید برنامه کنترل های لرزه ای مربوط به سیستم باربر جانبی را انجام دهد، در قسمتIgnore Seismic Code? 

را انتخاب نمایید. این بدان معناست که کنترل های طرح لرزه ای روی سازه صورت پذیرد. این کنترلها برای هر نوع قاب  Noگزینه 

ل ذکر گردید متفاوت می باشد. اما برای همه انواع قابها طرح لرزه ای شامل کنترل فشردگی مقاطع )بجز مطابق آنچه در قسمتهای قب

 ( و محاسبه نیروی محوری ستون تحت ترکیبات بار تشدید یافته وجود دارد.OMFسیستم 

  در صورتی که در قسمت قبل گزینهNo ید یافته را بطور اتوماتیک ساخته و را انتخاب کرده باشید و بخواهید برنامه ترکیبات بار تشد

را انتخاب کنید. این انتخاب بدان مفهوم است که  Noگزینه  ?Ignore Special Seismic Loadبر سازه اعمال نماید، در قسمت 

ین انتخاب کنیم، تفاوتی نمی کند در ا Yesستونها تحت اثر ترکیبات بار تشدید یافته کنترل شوند. درصورتی که در قسمت قبل 

قسمت چه گزینه ای را انتخاب نماییم. در صورتی که بخواهید خودتان ستونها را برای ترکیبات بار ویژه کنترل نمایید، هر دو گزینه 

Ignore Seismic Code?  وIgnore Special Seismic Load?  راYES .انتخاب کنید 

یافته ای که خود بصورت اتوماتیک می سازد کنترل نماید، کافی است  بنابراین اگر نخواهیم برنامه ستونها را ترکیبات بار تشدید: نکته

 را انتخاب نماییم. Yesگزینه  ?Ignore Special Seismic Loadو یا  ?Ignore Seismic Codeدر یکی از دو قسمت 

را   Include…Do Notو یا  …Includeگزینه  Special Seismic Load EffectsDefine<در قسمت : مستقل از آنکه نکته

( Options>Preferences>Steel Frame Defineانتخاب نمایید، برای برنامه ملاک آن چیزی است که در این قسمت )منوی 

این کنترل ها را فعال  Defineانتخاب می نمایید. بدین معنی که اگر در این قسمت کنترل های لرزه ای را فعال کنید، چه در منوی 

ید، کنترل لرزه ای انجام خواهد پذیرفت. وبرعکس اگر در این قسمت کنترل های لرزه ای را غیرفعال کرده و چه غیرفعال کرده باش

چه چیزی انتخاب شده باشد، این کنترل ها صورت نمی پذیرد. تنها در صورتی که منوی  Defineباشید، مستقل از آنکه در منوی 
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Define 0را فعال کنید، برنامه مقدارΩ ت قرائت کرده و نسبت به آنچه در منوی را از این قسمOptions  وارد نموده اید، برتری

 خواهد داد.

  در قسمتIs Doubler Plate Plug Welded?  مشخص نمایید که در صورتی که نوع قاب راIMF  یاSMF  ،انتخاب کرده اید

مضاعف به جان ستون جوش انگشتانه شکل جوش انگشتانه می دهید یا خیر. درصورتی که ورق  Hورق مضاعف را به جان ستون 

ن مجموع ضخامت جان ستون و ورق مضاعف را برای کنترل ضابطه پایداری ورق جان ستون در نظر شود، مطابق آئین نامه می توا

 گرفت.

  دو گزینهHSS Welding Type  وReduce HSS Thickness?  به این خاطر است که مطابق آئین نامهAISC360-05  و مبحث

 0.93باشد،  ERW (Electric-Resistant-Welding)ران برای مقاطع توخالی )باکس و لوله( در صورتی که نوع جوشکاری دهم ای

 برشی مقطع در نظر گرفته می شود.  ضخامت ورق پروفیل در محاسبات

  گزینهConsider Deflection? قیقاً مانند آنچه در و تنظیمات بعدی برای کنترل خیز تیرها برای حالت حدی بهره برداری و د

 روش تنش مجاز داشتیم می باشد.

  گزینهPattern Live Load Factor  برای در نظر گرفتن نامساعدترین وضعیت  بارگذاری زنده روی تیر متصل به یک کنسول

ه روی ارهای مردوقتی کنسول و تیر مجاور بصورت صلب به ستون متصل شوند استفاده می شود. در این حالت برنامه لنگر ناشی از ب

تیر کنارکنسول را محاسبه کرده و سپس لنگر ناشی از درصدی بار زنده روی تیر کنار کنسول با فرض اینکه تیر دو سر ساده است را 

نیز محاسبه می نماید. حال جمع لنگر بارهای مرده و زنده را برای تیر کنار کنسول محاسبه نموده و با هم جمع می نماید. بین این 

 0د اگر عد و وضعیتی که کل بار مرده و زنده روی تیر می باشد، آنکه لنگر بیشتری را حاصل کند معیار طراحی خواهد بود. وضعیت

 را در این قسمت وارد نمایید به معنی عدم در نظر گرفتن این وضعیت می باشد.

  گزینه هایStress Ratio Limit  وMaximum Auto Iteration  را به ترتیب حد نسبت نیرو به مقاومت مجاز و همچنین

 تعداد تکراهای تحلیل و طراحی که بصورت اتوماتیک توسط برنامه اعمال می شود وارد نمایید.

 

شده و هم ترکیبات بار  Design > Steel Frame Design > Select Design Comboپس از انجام تنظمیات طراحی، وارد قسمت  -15

Strength ترکیبات بار  و همDeflection  پیش فرض برنامه را بیرون بریزید. سپس ترکیبات باری که قبلاً برای طراحی تعریف کرده اید را

ترکیبات بار پیش فرض آئین نامه را به ترکیبات بار انتخاب شده ،  Runپس از هر بار  ETABS 9.7.4انتخاب نمایید. بایستی دقت کرد برنامه 

 ETABS 2013این عیب در  گام طراحی می افزاید و باید دوباره عمل مزبور را قبل از طراحی سازه انتخاب نمایید. البتهقسمت، در هن در این

 برطرف شده است.

 Kانتخاب کرده اید، برای ستونها لازم نیست هیچ مقداری را برای  Direct Analysisبا توجه به اینکه نوع تحلیل و طراحی برای پایداری را  -11

 را اصلاً قرائت نمی کند. Kطول مؤثر( معرفی نمایید. چون در این حالت برنامه مقادیر معرفی شده برای )ضریب 

 Design > Steel Frame Design > View/Reviseتمامی تیرهایی که در داخل سقف مدفون شده اند انتخاب کرده و با استفاده از گزینه  -11

Overwrite پیچشی را در قسمت  -عیار کمانش جانبیمقدار طول مهار نشده برای کنترل مUnbraced Length Ratio (LTB)  مانند شکل

را انجام می دهد. برای آنکه این کنترل برای  KL/r≤200( یک عدد کوچک وارد کنید. برنامه برای تمامی اعضاء فشاری و خمشی، کنترل 14)

را نیز در این قسمت عددی  Unbraced Length Ratio (Minor)و  Unbraced Length Ratio (Major)تیر صورت نگیرد، دو ضریب 

و سپس محاسبه ظرفیت فشاری ستونها  KL/rاز اعداد وارد شده در این دو قسمت اخیر فقط برای محاسبه  ETABSکم وارد نمایید. کلاً برنامه 

 استفاده می نماید.
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را برای این تیرها انجام ندهد، دو ضریب  KL/r≤200برنامه کنترل  تیرهایی که در داخل سقف مدفون نیستند را انتخاب نموده و برای آنکه -19

Unbraced Length Ratio (Major)  وUnbraced Length Ratio (Major) ( (.10را اعداد کمی وارد نمایید )شکل) 

 Unbraced Length)را انتخاب کرده و دستور قسمت قبل را اجراء کنید. حال در این قسمت نسبت طول مهار نشده  مهاربندهای نوع ضربدری -14

Ratio)  را حول محورهای اصلی و فرعی(Major – Minor)  ( وارد نمایید. دوباره یادآوری 11مطابق شکل ) 0.7و  0.5به ترتیب برابر اعداد

برنامه مقادیر ضریب طول مؤثر حول دو محور را قرائت نمی کند و هر اعدادی در  Direct Analysisروش می شود که با توجه به استفاده از 

 معرفی کنیم بدون استفاده است. Effective Length Factor (K Minor)و  Effective Length Factor (K Major)قسمت 

 

بال فشاری تیرهای مدفون در سقف، همچنین ضرایب طول تیر حول دو محور برای خنثی  وارد کردن نسبت فاصله مهارجانبی (14) شکل

 برای این اعضاء KL/r≤200کردن کنترل 
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وارد کردن نسبت فاصله مهارجانبی بال فشاری تیرهای مدفون در سقف، همچنین ضرایب طول تیر حول دو محور برای خنثی  (10) شکل

 برای این اعضاء KL/r≤200کردن کنترل 
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 وارد کردن نسبت فاصله طول مهارنشده مهاربندهای ضربدری حول محورهای اصلی و فرعی (11) شکل
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 :به موارد زیر دقت نمایید Design > Steel Frame Design > View/Revise Overwriteدر قسمت  -10

  در برنامهETABS  با آنکه در قسمتOptions > Preferences > Steel Frame Design  را می توان برای نوع سیستم لرزه بر

 Frameکرد. گزینه  Overwriteکل سیستم مشخص نمود، برای هر عضو نیز می توان بطور جداگانه سیستم لرزه بر دیگری را 

Type .در این قسمت بدین منظور است  

  گزینه هایUnbraced Length Ratio (Major , Minor)  تنها برای محاسبه ظرفیت اسمی فشاری)n(P  اعضاء بر اساس معیار

کمانش خمشی توسط برنامه استفاده می شود و در محاسبه ظرفیت تیرها بی تأثیر است. این ضرایب در طول عضو حول محورهای 

 بر را ضرایب اصلی و فرعی ضرب شده و برای محاسبه لاغری ستون حول دو محور استفاده می شود. برنامه بطور پیش فرض این

این ضرایب در فرم خلاصه محاسبات طراحی عضو  .نماید می محاسبه تحتانی و فوقانی گاه تکیه یا تیر بین نستو خالص طول اساس

 معرفی می شود. L Factorبا نام 

  گزینهUnbraced Length Ratio (LTB)  در طول عضو ضرب شده و در تیرها برای محاسبه ظرفیت خمشی تیر بر اساس معیار

 بر اساس معیار کمانش پیچشی استفاده می شود. n(P(تونها برای محاسبه ظرفیت اسمی فشاری پیچشی و در س -کمانش جانبی

این ضریب کاربرد ندارد. زیرا معیار کمانش پیچشی حاکم بر طرح ستون نبوده  BOXبرای ستونهای با مقاطع جدار نازک بسته مثل 

در نظرمی  Unbraced Length Ratio (Minor)برنامه بطور پیش فرض این ضریب را برابر و توسط برنامه محاسبه نمی شود.

 معرفی می شود. Lltbاین ضریب در فرم خلاصه محاسبات طراحی عضو با نام  گیرد.

  ضرایبEffective Length Factor (K Major , K Minor)  فقط وقتی که از روشEffective Length  استفاده شود کاربرد

باشد توسط برنامه قرائت نمی شود. این ضریب در فرم خلاصه محاسبات طراحی عضو  Direct Analysisرد. و اگر روش انتخابی اد

معرفی می شود. این ضرایب در طول مهار نشده ستون ضرب شده و پس از محاسبه لاغری عضو از آن برای محاسبه ظرفیت  K2با نام 

 شی و با استفاده از فرمول زیر استفاده می شود:فشاری ستون بر اساس معیار کمانش خم
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 فرمولهای محاسبه ظرفیت اسمی فشاری عضو بر اساس معیار کمانش خمشی (17) شکل

 

  مقادیرEffective Length Factor (K Major Braced , K Minor Braced)  که در خروجی های محاسبات برنامه به نام

K1 ای بدون حرکت جانبی یعنی معرفی می گردد، در محاسبه ضریب تشدید بارهB1  .استفاده می شوندETABS  بطور محافظه

همانطور که قبلاً گفته شد برنامه ضریب  شود. Overwriteدر نظر می گیرد مگر آنکه توسط کاربر  1.0کارانه این ضریب را برابر 

B2  در نظر می گیرد. اما ضریب  1.0را محاسبه نکرده و همواره برابرB1 نماید. فرمول محاسبه  را محاسبه میB1 :به قرار زیر است 

 

 

 

 

 

 

 

 B1فرمولهای محاسبه ضریب  (10) شکل
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  ضریبEffective Length Factor (K LTB)  ضریبی طول مؤثر پیچشی است که پس از ضرب در طول مهارنشده پیچشی ستون

این  ETABS برنامهمحاسبه می شود.  و بر اساس لاغری بدست آمده، ظرفیت نظیر اسمی فشاری بر اساس معیار کمانش پیچشی

 Effective Length Factor (Kبطور پیش فرض برابرمعرفی می کند،  Kltbکه در فرم های خلاصه محاسبات بنام را  ضریب

Minor) ،آنکه مقدار دیگری مگر در نظر می گیرد Overwrite  .برنامه شودETABS  برای مقاطع غیر تنهاSD  یا غیرGeneral 

برای مقاطع با دو . ظرفیت فشاری بر اساس معیار کمانش پیچشی را محاسبه می نمایدلوله و قوطی(  جدارنازک بسته )غیرو غیر 

( 17بر اساس فرمول زیر محاسبه شده و سپس با استفاده از فرمولهای شکل ) eFشکل( بطور مثال ایتدا  Hمحور تقارن )مثل ستون 

 معیار کمانش پیچشی بدست می آید. ظرفیت فشاری بر اساس E3-3تا  E3-1از 

 

 عضو فشاری بر اساس معیار کمانش پیچشی برای مقاطع با دو محور تقارن eFفرمول محاسبه  (19) شکل

 

  ضریبCb  یا ضریب لنگر یکنواخت، برای محاسبه ظرفیت اسمی خمشی تیرهایی که فاصله مهار جانبی بال فشاری آنها از مقدارLp 

معرفی شده در آئین نامه بیشتر است، استفاده می شود. این ضریب توسط برنامه محاسبه می شود مگر آنکه در این قسمت مقدار 

 شود. Overwriteدیگری برای آن 

 ضرایبMoment Coefficient (Cm Major , Cm Minor)    همان ضرایبCm  حول دو محور مقطع هستند که در محاسبه

 ( آورده شده است.10در شکل ) Cmمحور استفاده می شوند. فرمولهای محاسبه ضریب حول دو  B1ضرایب 

  در قسمتNonSway Moment Factor (B1 Major , B1 Minor)  می توان ضرایبB1  را حول دو محور عضوOverwrite 

محور عضو را حول دو  B2می توان ضرایب  Sway Moment Factor (B2 Major , B2 Minor)کرد. همچنین در قسمت 

مقادیر  ETABSبرای در نظر گرفتن آثار مرتبه دوم استفاده نمایید، برنامه  Order stAmplified 1تغییر داد. تنها وقتی از روش 

Overwrite  شده برایB1  وB2 .را قرائت می کند 

  در قسمتOverstrength factor, Ry  مورد انتظار به تنش تسلیم می توانید مقدار اضافه مقاومت مصالح )نسبت تنش تسلیم

و برای مقاطع  1/1، برای مقاطع نورد شده  10/1حداقل مصالح( را معرفی کنید. این ضریب برای مقاطع نورد شده لوله و قوطی 

ظرفیت اتصال تیر به ستون یا  ETABSمی باشد. در برخی از انواع سیستم های لرزه ای، برنامه  10/1ساخته شده از ورق برابر 

 مورد استفاده قرار می گیرد. Ryندی را نیز ارائه می دهد. در این خروجی ها ممکن است ضریب مهارب

  برنامهETABS  مقادیر ظرفیت اسمی فشاری(Pnc) کششی ،(Pnt) 3و2، خمشی حول محورهای (Mn3 , Mn2)  برشی در ،

 کند. Overwriteرا محاسبه می نماید. اما کاربر می تواند این مقادیر را  (Vn2,Vn3) 3و2راستای محورهای 
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 Design > Steel Frameها، می توان با اجرای دستور  Overwriteپس از انجام تنظیمات طراحی، انتخاب ترکیبات بار طرح و مقادیر  -11

Design > Start Design/Check of Structure .به طراحی سازه پرداخت 

با کلیک راست روی هر عضو طراحی شده می توان ریز محاسبات مربوط به هر عضو را مشاهده نمود. بطور مثال با کلیلک راست روی یک ستون  -17

 : پنچره ای مانند شکل زیر ظاهر می شود Detailsکنار مهاربند و انتخاب دکمه 

 

 LRFDجزئیات طراحی یک ستون به روش (15) شکل

 

 پنجره تنظیمات آئین نامه ای، مشخصات عضو، مشخصات پروفیل نمایش داده شود در سطرهای ابتدایی این ملاحظه می  همانطورکه

نسبت نیرو به ظرفیت عضو نمایش داده شده است که جمع ناشی از مقادیر مربوط به نیروی  D/C Ratioشده است. در قسمت 

شود برای ستون انتخابی با توجه به آنکه ترکیبات بار تشدید محوری و لنگرهای خمشی حول دو محور است. همانطور که ملاحظه می 

یافته حاکم شده اند، فقط نسبت نیرو به ظرفیت مربوط به نیروی محوری مقدار دارد و مقادیر نظیر مربوط به لنگرهای خمشی صفر 

شود نیز همانطور که مشاهده می  STRESS CHECK FORCES & MOMENTS (Combo COMB….)هستند. در قسمت 
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فرمولی ارائه شده است که مربوط به کنترل ستون برای ترکیبات بار تشدید یافته می باشد باز هم نشان دهنده آن است که در طرح 

 این ستون ترکیبات بار تشدید یافته حاکم شده اند.

  در قسمت بعدی مقادیرL ،K1 ،K2 ،B1 ،B2  وCm  را که کاربر معرفی کرده و یا توسط برنامه محاسبه و در نظر گرفته شده اند

 وارد شده یا محاسبه شده ارائه گردیده اند. Cbو  Lltb  ،Kltbنمایش داده می شود. همچنین در خط بعدی مقادیر 

  در قسمت بعد نیروی محوری نهایی ستون(Pu)  در ترکیب بار حاکم، ظرفیت فشاری طراحی(phi*Pnc)  ظرفیت کششی طراحی و

(phi*Pnt)  ارائه گردیده است. ظرفیت کششی طراحی بر اساس کمترین مقدار بدست آمده از دو معیار تسلیم و گسیختگی محاسبه

می گردد. ظرفیت فشاری طراحی نیز حداقل مربوط به دو معیار کمانش خمشی و کمانش پیچشی )در صورتی که برای پروفیل 

و لوله( و همچنین  Boxکنترل شده باشد( می باشد. همانطور که گفته شد برنامه برای پروفیلهای جدارنازک بسته )مربوطه این معیار 

معیار کمانش پیچشی را برای محاسبه ظرفیت فشاری عضو در نظر نمی گیرد. برای آنکه بدانیم آیا برنامه  Generalیا  SDمقاطع 

که در محاسبات این معیار استفاده می شود در فرم  Cwگرفته است یا خیر به پارامتر  این معیار را در محاسبه ظرفیت ستون در نظر

جزئیات محاسبات دقت کنید. اگر این پارامتر نشان داده شده باشد، نشان از آن است که این معیار برای پروفیل مورد نظر توسط 

 برنامه در نظر گرفته شده است.

 

 کمانش پیچشی در محاسبه ظرفیت فشاری عضوو در نظر گرفتن معیار  Cwپارامتر  (11) شکل
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  در قسمت بعدی مقادیر لنگر خمشی نهایی عضو در ترکیب بار مورد بررسیMu  ظرفیت خمشی طراحی عضو با در نظر گرفتن ،

و ظرفیت خمشی طراحی عضو بدون در نظر  phi*Mnپیچشی(  -معیارهای تسلیم، کمانش موضعی و کمانش کلی )کمانش جانبی

ارائه شده است. به عبارت دیگر در آخری ظرفیت خمشی طراحی عضو فقط با در نظر  phi*Mn No LTBیار کمانش کلی گرفتن مع

را نشان می دهد. برای  phi * ZFyگرفتن معیارهای تسلیم و کمانش موضعی است که اگر پروفیلی فشرده باشد، این عدد مقدار 

ارائه می شود، بدون آنکه هیچ کدام از سه معیار مربوطه کنترل  phi*SFyدر این دو قسمت فقط مقدار  Generalیا  SDمقاطع 

 شوند.

 در ترکیب بار انتخاب شده  جعبه ای )باکس( و لوله ایطع ادر قسمت بعد مقادیر لنگر پیچشی نهایی مقTu ظرفیت پیچشی اسمی ،

Tn  و ظرفیت پیچشی طراحیphi*Tn  ارائه شده است. بر خلاف طراحی بر اساس آئین نامهAISC-ASD89  که برنامه محاسبات

در مقاطع در برنامه استفاده کنید، کنترل برای پیچش نیز  AISC360-05اعضاء برای پیچش را انجام نمی داد، وقتی از آئین نامه 

 صورت می گیرد.ذکر شده 

  ترکیب بار مورد نظر در قسمت آخر نیز نیروی برشی نهایی مقطع درVu  در راستای هر دو محور پروفیل و همچنین مقدار ظرفیت

 ارائه گردیده است. Stress Ratioو نسبت نیرو به ظرفیت برشی  phi*Vnطراحی برشی تیر 

 

و ترکیب بار شامل نیروی نامتعادل طرح شوند. بنابراین می بایست  می بایست برای ترکیب بارهای ثقلی 0و  7تیرهای متصل به مهاربندهای  -10

شود محاسبه نماییم. توصیه می دوباره مدل دیگری ذخیره کرده و با حذف مهاربندهای شورون و اعمال نیروهای نامتعادل، تیرهای مربوطه را 

 0و  7پروفیل یکسان استفاده گردد. همچنین لاغری مهاربندهای  متوالی با مقطع 0و  7نباشد از مهاربندهای  برای آنکه نیاز با این محاسبات

بایست می نیز  این کنترل انتخاب کرده باشید، OMFکه در صورتی که نوع سیستم لرزه بر را  بیشتر شود 110نباید از عدد مطابق آئین نامه نیز 

 .بصورت دستی صورت پذیرد

 

 نکته تکمیلیچند 

با  Pro.*بسازید و یا از پروفیهای تعریف شده در فایلهای  SDدر برنامه  ETABSکه مقاطع تیرها را در همانطور که گفته شد، در صورتی  (1

بدون آنکه بر اساس سه معیار حالت حدی تسلیم، کمانش موضعی و کمانش کلی  ETABSاستفاده کنید، برنامه  Generalمقاطع نوع 

در نظر می گیرد. به نکات زیر  SFyه نماید، مقاومت خمشی اسمی را برابر پیچشی( مقاومت اسمی خمشی تیر را محاسب -)کمانش جانبی

 در این باره توجه نمایید:

  در صورتی که تیر تعریف شده در برنامهSD  پروفیلI باشد، به شرط آنکه تیر در داخل  نورد شده با ورق تقویتی و جوش غیرپیوسته

سقف مدفون شده باشد، فرض در نظر گرفته شده توسط برنامه برای مقاومت خمشی می تواند معقول باشد. دقت کنید که در روش 

، به شرط آنکه مهارجانبی مناسب pf≤λf(λ(در صورتی که لاغری موضعی بال طوری باشد که تیر فشرده حساب شود  LRFDطراحی 

خواهد بود. اگر در همین تیر نسبت لاغری موضعی  ZFy، مقاومت اسمی خمشی برابر p≤Lb(L(ال فشاری وجود داشته باشد برای ب

خواهد بود. در صورتی که  SFy 0.7مقاومت اسمی خمشی برابر   fr=λf(λ( بال طوری باشد که دقیقاً تیر غیر فشرده محسوب شود

بصورت خطی تغییر  SFy 0.7و  ZFyمقاومت اسمی خمشی بین دو مقدار  fr≤λ f≤ λfp(λ(لاغری موضعی بال بین این دو  مرز باشد 

خواهد کرد. این مطلب بر خلاف آن چیزی است که در روش تنش مجاز داشتیم. در روش تنش مجاز اگر پروفیلی فشرده بود مقاومت 

 تغییر خطی مقاومت را نداشتیم. می بود و SFy 0.6می شد و اگر این مرز را رد می کرد  SFy 0.66خمشی مجاز آن 
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  در صورتی که تیر تعریف شده در برنامهSD  پروفیلI  نورد شده با ورق تقویتی و جوش پیوسته باشد، به شرط آنکه تیر در داخل

در نظر گرفت.  ZFyکه فرض برنامه برای مقاومت اسمی خمشی این نوع مقاطع است،  SFyسقف مدفون باشد، می توان به جای 

معرفی نمود، طوری که مشخصات جان آن دقیقاً مانند مشخصات  I/Wide Flangeشکل در قسمت  Iبدین منظور می توان تیری 

تیر اولیه بوده ولی ضخامت بال آن برابر مجموع ضخامت بال تیر نورد شده و ورق تقویتی باشد. عرض این تیر طوری تعیین می شود 

کل برابر مساحت بال تیر نورد شده بعلاوه ورق تقویتی باشد. بجای این روش می توان از روش تقریبی زیر ش  Iکه مساحت بال تیر

است، می توان برای پروفیلهای فشرده ای که در برنامه  1.2تا  1.1بین  Z/Sشکل نسبت  Iاستفاده کرد. از آنجا که در پروفیلهای 

SD  1.1تنش تسلیم آن تعریف می شوند، مصالح دیگری تعریف نمود که Fy .می باشد 

 می  پیچشی -در صورتی که تیری در داخل سقف مدفون نباشد، با توجه به آنکه مقاومت اسمی خمشی بر اساس معیار کمانش جانبی

ده تعریف ش Iاستفاده کرد. بنابراین یا برای این تیرها از مقطع  SDبایست محاسبه گردد، نمی توان از مقطع ساخته شده در برنامه 

شکل با ورق  I( استفاده کنید و یا اگر می خواهید تیری I/Wide Flangeشده در قسمت  Importتوسط برنامه )تعریف شده یا 

 شکل با بال مساحت معادل تعریف نمایید. Iتقویتی تعریف نمایید، با روش ذکر شده در بند قبلی، تیری 

 امه در طراحی تیرهای کامپوزیت، همانطور که می دانید، برنETABS  تنها پروفیلهایI  را طراحی می کند. بنابراین  ناودانیشکل یا

شکل معادلی را که هم ارتفاع پروفیل لانه زنبوری بوده ولی بقیه  Iدر صورت استفاده از مقاطع لانه زنبوری، می بایست مقاطع 

شکل معادل سازی  Iاین مقاطع را با مقاطع  آماده ای که Pro.*مشخصات آن با پروفیل اصلی یکسان است، تعریف نمود. فایلهای 

 Iبا فرض مقطع فشرده با این پروفیلهای  ETABSکرده اند موجود است. در استفاده از آنها بایستی به این نکته دقت کرد که برنامه 

می گیرد. با توجه  SFyبه جای حداکثر  ZFyشکل جدید برخورد کرده و مثلاً مقاومت اسمی خمشی تیر را قبل از گیرش بتن برابر 

(، می توان برای پروفیلهای لانه زنبوری معادل 1.1تا  1.0است )بین  1.1کمتر از  Z/Sبه آنکه در پروفیلهای لانه زنبوری نسبت 

 باشد. Fy/1.1شکل، مصالح فولادی ای تعریف کرد که تنش تسلیم آن  Iسازی شده با پروفیل 

 

می تواند نیروی محوری ستونها را تحت اثر ترکیبات بار تشدید یافته کنترل کند. می توان بجای  ETABSهمانطور که در قبل گفته شد  (1

 این روش، کنترل لرزه ای برنامه را غیرفعال کرده و بصورت دستی این کار را انجام دهیم. بدین منظور کافی است ابتدا ترکیبات بار تشدید

مربوط به ترکیبات بارگذاری معاونت شهرسازی و معماری  99-151-1ستورالعمل شماره ضمیمه د ETABSیافته را ایجاد کرده )در فایل 

 Design > Steel Frameشهرداری شیراز، این ترکیبات بار قرار داده شده اند.( و سپس به قرار زیر آنها را اعمال کنید. ابتدا در قسمت 

Design > Select Design Combo نتخاب کنید. سپس تمامی ستونها را انتخاب نموده و در قسمت ترکیبات بار تشدید یافته را ا

Design > Steel Frame Design > View/Revise Overwrites  ظرفیت اسمی خمشی ستونها را حول هر دو محور(Mn3 , 

Mn2) افته ات بار تشدید یعددی بزرگ مانند شکل زیر وارد کنید. سپس دکمه طراحی سازه فولادی را کلیک کرده تا ستونها برای ترکیب

کنترل و طراحی گردیده و نسبت های نیرو به ظرفیت اعضاء نمایش داده شود. نیاز به کنترل دستی ستونها تحت ترکیبات بار تشدید یافته 

 می تواند به دلایل زیر صورت گیرد:

  مطابق آئین نامهAISC360-05  در صورتی که نسبتPu/φPn  کنترل ستون تحت ترکیبات بار کمتر باشد، نیاز به  0.4ستون از

حذف شده است. به عبارت دیگر کنترل ستونها برای زلزله تشدید یافته  AISC360-10تشدید یافته نیست. این شرط در آئین نامه 

 AISC360-05طراحی بر اساس آئین نامه  ETABS 9.7.4در تحت تمامی مقادیر نیروی محوری ستون می بایست صورت گیرد. 

می باشد. بنابراین  AISC360-10ترجمه  1991مطابقت داشت. مبحث دهم ویرایش  1907با مبحث دهم ویرایش  وجود دارد که

عمل کنیم می بایست بصورت دستی ترکیبات بار تشدید یافته را اثر دهیم. نکته  1991برای آنکه بطور کامل مطابق مبحث دهم 

مربوط  MANUALنیز افزوده شده است، اما اگر در  AISC360-10گزینه طراحی بر اساس  ETABS 2013دیگر آنکه هرچند در 
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همانی است  AISC360-10به روال طراحی بر اساس این آئین نامه در نرم افزار بنگریم، متوجه می شویم که موتور طراحی بر اساس 

مورد از ایردات برنامه می باشد  بوده است و روال طراحی مزبور هیچ تغییری نکرده است. که طبیعتاً این AISC360-05که مربوط به 

 و احتمالاً در ویرایش های بعدی اصلاح می گردد.

  در صورتی که ازETABS  برای طراحی تحت ترکیبات بار تشدید یافته استفاده کنید، این برنامه خود ترکیبات بار مربوطه را بصورت

 0.2و ضریب بار برف بام  0.5وان گفت که ضریب بار زنده داخلی می سازد. در ترکیبات بار پیش فرض ساخته شده در برنامه نمی ت

در نظر گرفته می شود که این امر موجب کمی غیراقتصادی طرح شدن ستونها  1.0اعمال گردد و ضریب بار همگی بارهای زنده 

 خواهد شد.

  در صورتی که بار زلزله قائم را بصورت یکLoad Case  از نوعQUAKE  در برنامهETABS کنیم و بجای آن، این اثر در تعریف ن

عمل شده است(، برنامه  99-151-1ضمیمه دستورالعمل شماره  ETABSترکیبات بارگذاری معرفی شوند، )مانند آنچه در فایل 

ETABS  .حالت بار زلزله قائم را وارد ترکیب بار تشدید یافته ای که خود بصورت داخلی می سازد نمی کند 
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 ستونها جهت کنترل تحت ترکیبات بار تشدید یافته Mn2و  Mn3وارد نمودن مقادیر زیاد برای  (11) شکل
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 استفاده می کنید، به نکات زیر دقت کنید: LRFDبرای طراحی سازه فولادی به روش  ETABS 2013در صورتی که از  (0

  همانطور که گفته شد، هر چند در برنامهETABS 2013  طراحی بر اساسAISC360-10  نیز اضافه شده است، اما مطابق

MANUAL  برنامه، طراحی هنوز بر اساس روال آئین نامهAISC360-05  صورت می گیرد. دقت کنید که در زمینه تمهیدات لرزه

 این عیب برطرف نشده بود.( 13.1.4ای این دو آئین نامه با یکدیگر تفاوت دارند. )تا ویرایش 

  بر خلاف نرم افزارETABS 9.7.4 پارامترهای لرزه ای در دو قسمت مختلف، یکی در منوی  کهDefine  و دیگری در منویOptions 

> Design Preferences  پرسیده می شد، درETABS 2013  تنها در قسمتDesign > Steel Frame Design > Design 

Preferences  لی برطرف شده است. اما ایرادی که در تمامی پارامترها پرسیده می شود. بنابراین نقص مربوطه در ویرایش قب

2013 ETABS  0موجود است آن است که هر مقداری برایΩ   در این قسمت معرفی شود برنامخ همواره این ضریب را در محاسبات

 Overwriteدر نظر می گیرد. برای رفع این مشکل کافی است کل سازه را انتخاب کرده و مقدار پارامتر مزبور را یک بار  9ود عدد خ

 این عیب برطرف نشده بود.( 13.1.4کنید.  )تا ویرایش 

  عیبی که در نرم افزارETABS 9.7.4  وجود داشت و در نرم افزارETABS 2013  برطرف شده آن است که در نرم افزار قبلی برنامه

ست طراحی اضافه می کرد که این امر همواره ترکیبات بار پیش فرض خود را علاوه بر ترکیبات بار انتخاب شده توسط کاربر به لی

برطرف شده است. هر چند در متن های قبلی بیان گردید که  ETABS 2013باعث کمی سنگین شدن سازه می شود. این عیب در 

نیز هر بار پس از تحلیل با حذف هم ترکیبات بار پیش فرض طراحی و هم ترکیبات بار پیش فرض  ETABS 9.7.4می توان در 

 بصورت تؤمان، این مشکل را برطرف کرد. کنترل خیز،

 

بطور اتوماتیک مقادیر سختی را کاهش می  ETABSدر طراحی،  Direct Analysisهمانطور که گفته شد در هنگام استفاده از روش  (4

داری غیر از روش بایستی مدلی دیگر داشت که روش طرح پای Driftطبقات افزایش می یابد. اما برای کنترل  Driftدهد. بنابراین مقادیر 

Direct Analysis  باشد. همیشه مقادیرDrift  دریفت ارائه شده در روش  %05واقعی مساوی یا کمتر ازDirect Analysis  .است

ضرب کرد. همچنین مقادیر  0.8را در عدد  ETABSبنابراین می توان برای کنترل دریفت بطور محافظه کارانه مقادیر دریفت ارائه شده در 

0.8√ارتعاش طبیعی سازه نیز تقریباً پریود  ≅  می باشد. Direct Analysisبرابر مقادیر ارائه شده در روش  0.9

 

با کاهش سختی، مقدار خیز تیرها نیز در تحلیل صورت گرفته بیشتر نشان داده می شود. اما خود برنامه در  Direct Analysisدر روش  (0

 کان واقعی استفاده می نماید و نیازی به انجام تغییر خاصی نیست.هنگام طراحی تیرها برای خیز، از مقدار تغییرم

 

در هنگام تحلیل سازه از سختی های کاهش یافته استفاده می شود. ولی در هنگام طراحی از همان سختی  Direct Analysisدر روش  (1

های واقعی استفاده می گردد. زیرا اثر کاهش سختی و غیر خطی شدن مصالح، در خود فرمولهای طراحی دیده شده اند. بطور مثال وقتی 

𝐹𝑒انش خمشی محاسبه نماییم، در فرمول اولر می خواهیم ظرفیت فشاری یک ستون را برای معیار کم =
𝜋2𝐸

𝜆2
 crFو یا در فرمول  ⁄

 کاهش نیافته استفاده می گردد. Eپیچشی از  -محاسبه ظرفیت تیرها برای کمانش جانبی

 

لرزه ای آئین برای آنکه برنامه بتواند ضوابط  OCBF ،IMF ، SMF  ،EBFدر صورت استفاده از سیستمهای لرزه ای موجود در برنامه مثل  (7

 Options>Prefrences>Steel Frame Designرا در قسمت  ?Ignore Seismic Codeنامه را کنترل نماید، می بایست گزینه 

 به نکات زیر توجه کنید:انتخاب کرد. در مورد کنترل های برنامه  Noگزینه 

  تحت اثر ترکیبات بار شامل نیروهای نامتعادل مهاربندها  نکنترل تیرهای مهاربند شوروبرای قابهای مهاربندی همگرای معمولی

 توسط برنامه صورت نگرفته و می بایست بصورت دستی و با ساختن مدل جداگانه صورت گیرد.
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49-1 50-1راهنمای شماره   

 ETABSنکات طراحی به روش حالت های حدی در 

 

  تحت اثر ترکیبات بار شامل نیروهای نامتعادل مهاربندها توسط برنامه صورت  کنترل کل سازهبرای قابهای مهاربندی همگرای ویژه

 می بایست بصورت دستی و با ساختن مدل جداگانه صورت گیرد. نگرفته و

  برای قابهای خمشی با شکل پذیری متوسط و ویژه کنترل ضابطه برش نظیر تشکیل مفصل پلاستیک در دو انتها تیر صلب، توسط

 برنامه صورت نگرفته و می بایست بصورت دستی کنترل شود.

 فقط برای وقتی صورت می گیرد که مقطع ستون  در برش یت چشمه اتصالکنترل کفا برای قاب های خمشی متوسط و ویژهI/Wide 

Flange  .همچنین این کنترل فقط در راستای محور جان پروفیل ستون صورت می گیرد. در صورتی که ضخامت جان مقطع باشد

H  شکل جوابگو نباشد، برنامه ضخامت ورق مضاعف(Doubler Plate) اهد کرد. در محاسبه این ضخامت را در خروجی ها اعمال خو

نوع جوش این ورق به ورق جان ستون )جوش انگشتانه یا خیر( مهم است که می توان آن را در قسمت 

Options>Prefrences>Steel Frame Design  در سطرIs Doubler Plate Plug Welded? .مشخص نمود 

 فقط وقتی مقطع ستون ویژه کنترل ضابطه ستون قوی و تیر ضعیف،  برای قابهای خمشیI/Wide Flange  .باشد صورت می گیرد

یل مفصل پلاستیک در بر ستون است که تنها در صورت استفاده از اتصال گیردار مستقیم حالت برنامه فرض می کند محل تشک در این

(WUF-W) .این فرض صحیح است 

 ی در تمام انواع قابهای خمشOMF, IMF, SMF  کنترل نیاز به سخت کننده ها در محل اتصال تیر به ستون برای ستونهای با مقطع

صورت می گیرد و در صورت نیاز ضخامت ورق سخت کننده اعمال می شود. هر چند همواره استفاده از ورق  I/Wide Flengeنوع 

 مقطع تیر توصیه شده است.سخت کننده ستون در مقابل اتصال صلب تیر به اندازه ضخامت بال 

  قابهای خمشی درIMF, SMF تیر از  هر دو بال برنامه کنترل می کند که فاصله بین مهارهای جانبیy F E / y0.17 r  برای قاب

و  y142 r به ترتیببرابر این اعداد ) ر نشودبیشت خمشی ویژهاب ق)نصف مقدار قبلی( برای   .yF E / yr 8600 و  توسطمخمشی 

y71 r صورتی که مقداری برای  در. (می بانشد(Minor) Unbraced Length Ratio  در قسمتOverwrite  وارد نشود، برنامه

ال هم بال فوقانی و هم باگر . بنابراین متصل به تیر مورد نظر فرض می کندبرابر فاصله تیرچه های  له بین مهارجانبی تیرها رااصف

( وارد نمایید. 51/5 مثال عدد به عنواناین ضریب را عدد کوچکی )چه بلوک است، مثلًا سقف تیرت، در سقف مدفون اس تیرتحتانی 

یر تپروفیل مقطع برنامه آنقدر  حالتاین وارد ننمایید. در  یچ ضریبی راهو عرشه فولادی، ، برای سقف کامپوزیت غیر این صورتدر 

ضابطه  بهتر این مقاطع بال پهن تر مناسب تر بودن بقیه مشخصات، ثابتا فرض به مزبور ارضاء شود. تا ضابط هدادافزایش را  ظرنمورد 

قف س نخواهید با افزایش مقطع این ضابطه کنترل شود، می توانید از سینه بند برای بستن بال تحتانی تیر بهاگر  .ردکخواهند  را ارضاء

 کنید.وارد  Unbraced Length Ratio (Minor)فاصله آنها را در قسمت استفاده نموده و نسبت 

ذکر یک نکته خالی از لطف نیست. در صورتی که سیستم سازه ای در یک جهت قاب خمشی و در جهت دیگر  این حالتبرای 

یش حاکم بر طرح و افزا یت یا عرشه فولادی باشد، برای آنکه ضابطه فاصله مهار جانبی دو بال تیر،مهاربندی بوده و نوع سقف کامپوز

 جانبی را ایجاد نمایند.د تا مهار مناسب مقطع نگردد، مناسب تر است که تیرچه های سقف بر روی تیرهای قاب خمشی قرار گیرن

  در صورت انتخاب قاب مهاربندی واگراEBF  برنامه تمامی کنترل های نیاز به فشردگی مقاطع، محاسبه تیر خارج پیوند، محاسبه

ستون کنار مهاربند، برای نیروهای اضافی ذکر شده در آئین نامه توسط خود برنامه صورت می گیرد. همچنین مهاربند و محاسبه 

دوران تیر پیوند نیز توسط برنامه انجام می پذیرد. تنها کاربر می بایست بر اساس میزان دوران تیر پیوند، فاصله سخت کننده کنترل 

های میانی را  تعیین کند که می توان بدون کنترل مقدار این دوران، ضوابط سخت گیرانه مربوط به فواصل سخت کننده ها، که برای 

 وند برشی است، را اعمال نمود.وقتی است که رفتار تیر پی




